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These release notes cover the upgrades we have added to MapInfo Professional 9.0.2. You can 
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Upgrading MapInfo Professional to 9.0.2
You can upgrade your local and network MapInfo Professional installation using 
the instructions given below. The version 9.0.2 includes the changes from MapInfo 
Professional version 9.0.1. We have also included an update of the Microsoft C 
Runtime VS2005 libraries in this maintenance release.

Note: You must have administrative rights to your machine to perform the 
upgrade. 

Upgrading MapInfo Professional Locally
Your computer must be connected to the Internet to download the upgrade.

To upgrade your computer using MapInfo Professional to version 9.0.2:

1. Launch MapInfo Professional 9.0 or 9.0.1 and select Help > Check For 
Update from the Main menu. The Maintenance Releases web page displays.

2. Create a temporary folder on your hard drive, such as c:\temp\mipro902.

3. On the web page, click the download link to display the File Download dialog 
box.

4. Choose the Save button and save the file to the temporary folder you created 
in step 2.

5. After the download is complete, close MapInfo Professional and double-click 
the downloaded file to begin the installation. Follow the instructions to 
complete the upgrade. You must agree to the License Agreement to install 
the maintenance release.

Note: Each computer needs to follow this same process. If you use a network 
server to run MapInfo Professional, see the next section.
1

http://gw.vtrenz.net/?LMK27OOIJ7
http://gw.vtrenz.net/?LMK27OOIJ7
http://gw.vtrenz.net/?LMK27OOIJ7
http://www.mapinfo.com


Upgrading a MapInfo Professional Network Installation
You must have administrative rights on the computer you are using to install MapInfo Professional 9.0.2. You can 
upgrade the network installation from any existing and connected network client.

To upgrade a network installation with MapInfo Professional 9.0.2:

1. Begin the process as described in Upgrading MapInfo Professional Locally. At step 5, when the installer detects 
the network installation, this message displays:

After you upgrade the Network installation, you need to install the Microsoft VS2005 libraries on each 
client. To do this, locate the VS2005RTMM.exe file on the network and double click it. 

2. Do one of the following:

• To continue the installation, click Yes. The installer upgrades your network installation. 

• To prevent the upgrade, click No and the installer ends. If you decide later that you do want to run the upgrade, 
you can begin it again and click Yes.

3. After you complete these steps, you do need to run the Microsoft VS2005 library upgrade from each individual 
client machine. We provide an executable to perform the upgrade of these libraries on the network at the following 
location:
<network installation directory>\Add Client\VS2005RTMM.exe

Installing the 9.0.2 Maintenance Release Silently
You can install the MapInfo Professional Maintenance release silently, meaning the installer runs without displaying 
any dialog boxes, after you run the command below. 

Note: You cannot perform a silent installation on a network. 

To do this:

• Run this command from the client computer’s command line:
<directory path>MapInfoPro902Patch.exe /s /a /s /v"SILINST=True"

where: 
/s = extracts the files silently into a temporary folder
/a = appends the following parameters to the internally launched setup.exe
/s = runs the installation silently
/v = passes the parameter "SILINST=True" into the release to suppress GUI 

Installing the Microsoft C Runtime VS2005 Libraries Silently from a Network Installation
To install the Microsoft VS2005 libraries silently from the network onto each client’s computer:

• Run this command from each client computer’s command line:
<network directory path>VS2005RTMM.exe /s /v"/qn"

A Note about Modifying or Repairing your Maintenance Release
If you install the version 9.0.2 of MapInfo Professional and then need to modify or repair the newly installed 
components or files, you may see some unexpected results. This is due to the version of the files you are replacing. If 
you find that the repair or modify process causes problems, we recommend that you uninstall the 9.0.2 maintenance 
release and then reinstall it to achieve the best results. 
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New Features Added in this Maintenance Release
The following topics refer to new capabilities that have been added to this maintenance release of MapInfo 
Professional.

Upgrades to Curved Labels Included
In this release we have introduced enhancements to make using labelling more consistent throughout the product. 
Many of these upgrades are due to what we learned when making the curved label changes.

Label Editing is More Consistent

Previously, when you created custom curved labels using the Label edit tool, MapInfo Professional positioned the 
labels to the right of the mouse click. To make this tool work consistently across all types of labels, the tool now 
positions or repositions curved labels based on the label's anchor position. Keep in mind that the curvature of the 
polyline determines whether you can create a curved label successfully. Polylines with sharp angles would not produce 
good curved labels so we do not allow them. 

When you use the Label edit tool to change the position of your label, your mouse click determines the new anchor 
position. So, to reposition a curved label, click the mouse on the polyline to select a new anchor position. When you do, 
the curved label position is set according to the vertical and horizontal aspects of the anchor position. For example, if 

you set the label’s anchor position to Center Left , the curved label you place is centered vertically on the polyline 
and to the left of the mouse click. When you edit labels this way, they are saved with the workspace. 

Additionally, we have been able to improve the curved label drawing speed when labels are using the same font 
properties. 

Text Angle Change Makes Better Looking Curved Labels 

We have increased the angle at which the characters of curved label text can display to increase the number of labels 
that are created and to improve the look of your maps.

Support for Bidirectional Labels Added

Previously, Hebrew and Arabic users reported that their curved labels did not display in the right to left format. This 
feature adds support for displaying curved labels with complex right to left reading scripts, which may have any of the 
following properties. 

Bidirectional Rendering
Bidirectional rendering, that is, the handling of text that reads both left-to-right and right-to-left, is now handled 
by this script addition. For example, when you are rendering Arabic, the default reading direction for the text is 
right-to-left, but it is left-to-right for some numbers. The script processing accounts for the difference between 
the logical (keystroke) order and the visual order of the characters. In addition, processing must properly deal 
with caret movement and hit testing. The mapping between screen position and a character index requires an 
understanding of the layout algorithms for the particular display, for example, selection of text or caret display.

Contextual Shaping
In contextual shaping, script characters change shape depending on the characters that surround them. Such 
shaping occurs in English cursive writing when a lowercase "l" changes shape depending on the character that 
precedes it, such as an "a" (connects low to the "l") or an "o" (connects high). In particular Arabic is a script that 
exhibits contextual shaping.

Combining Characters
Combining characters, also called "ligatures," are characters that join into one character when placed next to 
each other. Arabic is a script that has many such combining characters. One example of the use of combining 
characters is the "a" followed by "combining grave", for which the rendered representation is "à". The Unicode 
stream "U+0061 U+0300" requires some processing to ensure the "combining grave" is correctly positioned 
above the character "a". 
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The support for complex scripts is provided by using a Windows library called Uniscribe (USP10.DLL). This library 
handles contextual character shaping and  reorders bidirectional scripts such as Hebrew and Arabic. Its methods 
analyze and reorganize strings using complex scripts into separate runs which can then be reordered for display. This 
allows the correct contextual characters to display in the correct order for curved labels.

Raster Reprojection Available in MWS Format
Raster reprojection, which occurs when you open a registered raster image inside of a vector Map window with a 
different projection, or when you change the projection of a Map window, was introduced into MapInfo Professional in 
version 8.5. During the raster reprojection process, MapInfo Professional recalculates the pixel values of the source 
image to make them display correctly in the destination image. In the past, you could save this reprojection to .WOR-
type workspaces and not to the XML-format based MWS files used in MapXtreme. This was a problem when you 
opened raster reprojected MWS workspace files in MapXtreme because the raster reprojection was not specified in the 
XML elements.

To support interoperability of our products, we have created the RasterConditions XML element for raster reprojection. 
This element has 6 attributes, which are described below. Since not all of these attributes correlate to MapInfo 
Professional attributes, the missing MapInfo Professional attributes are set to the default values used in MapXtreme:

dither
This attribute has a value of "halfTone" (other supported value for MapXtreme is "errorDiffusion")

trueColor
This attribute has a value of "true" (the other supported value is "false")

optimizeRasterLayers
This attribute has a value of  "screen" (the other supported value is "printer") 

optimizeVectorLayers
This attribute has a value of  "screen" (the other supported value is "printer") 

Additionally, there are two new attributes that are relevant to raster reprojection in MWS files that are initialized from a 
Map window and are directly translated to MapXtreme:

rasterReprojectionResampling
This attribute can have values of "cubicConvolution" or "nearestNeighbor".

rasterReprojection
This attribute can have values of "none", "always" or "optimized"

MapInfo Professional 9.0.2 versions and later will now write the RasterConditions element to the MWS workspace and 
define all six attributes. This change will enable MapXtreme to open and display MapInfo Professional MWS files in the 
future. 

New Irish Transverse Mercator Projection Added
To accommodate the new Ordnance Survey projection for Ireland, we have added a new projection algorithm to 
MapInfo Professional. The Irish Transverse Mercator (ITM) is a newly derived GPS-compatible mapping projection that 
is associated with the ETRS89 and the GRS80 ellipsoids. You can use the new ITM projection to correctly transform 
data from the Irish Grid to the ITM projection. It involves replacing current datum conversion algorithm between datums 
42 (Ireland 1965) and datum 115 (EUREF89\ETRS89) with an algorithm using different datum conversion parameters. 

Currently, the MAPINFOW.PRJ entries for the Irish coordinate systems are:

"--- Irish Coordinate Systems ---"
"Irish Transverse Mercator Grid\p29902", 8, 42, 7, -8, 53.5, 1.000035, 200000, 250000

To use the new conversion algorithm in MapInfo Professional 9.02, use Notepad or another text editor to replace the 
MAPINFOW.PRJ entries above with the following entries:

"--- Irish Coordinate Systems ---"
"Irish Grid\p29902", 8, 42, 7, -8, 53.5, 1.000035, 200000, 250000
"Irish Transverse Mercator (ITM)\p2157", 8, 115, 7, -8, 53.5, 0.999820, 600000, 750000
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NTv2 Datum Transformation Conversion Added
The National Transformation v. 2 (NTv2) algorithm and grid shift file format, developed by the Geodetic Survey Division 
of Geomatics Canada, enables you to convert data between the NAD 27 reference system and the NAD 83 reference 
system; that is, this algorithm allows you to convert these two reference systems between each other. Grid shift files 
used with the algorithm contain one or more rectangular grids that indicate the coordinate differences between NAD 27 
and NAD 83. 

The National Transformation was originally designed to convert Canadian data from NAD 27 to NAD 83. The NTv2 grid 
was an enhancement to compensate for the primary and secondary points that were based on the GRS80 ellipsoid. 
This format was later adopted for datum conversion in Australia, New Zealand, and Germany.

MapInfo Professional has implemented the general NTv2 algorithm and this maintenance release installs grid shift files 
for each country to which this transformation applies. These countries and their grid shift file names are specified in the 
next section. 

Countries Served by this Conversion

Below is a description of supported NTv2 transformation grid shift files for each of the countries that use the NTv2 
algorithm:

Canada
There are two different grids for Canada. They convert between NAD 1927 or NAD 1927 (Definition 1976) and NAD 
1983. The NAD 1927 (Definition 1976) coordinate system is a readjustment of NAD 1927 for Ontario. The grid shift 
files are: 

• NTV2_0.GSB - used for converting NAD 1927 to NAD 1983 

• MAY76V20.GSB - used for converting NAD 1927 (Definition 1976) to NAD 1983 for Ontario

Detailed information about the algorithm, software and grid shift files can be downloaded from their web site: 

http://www.geod.nrcan.gc.ca/apps/ntv2/index_e.php

You can also use INTGRID program on this web site that allows you to convert coordinates interactively or to provide a 
list of points to be converted. This program is included on an NTv2 CD.

To use the NAD 1927 for Ontario instead of the generic NTv2 grid shift file for all of Canada:

• Remove or rename the NTV2_0.gsb file in your MapInfo Professional program directory

Australia
The Australian grids convert between either AGD 1966 or AGD 1984 and GDA 1994. It contains two grid shift files:

• A66_National.gsb - used for converting AGD 1966 to GDA94.

• National_84.gsb - used for converting AGD 1984 to GDA94 

It also contains links to the software that can be used for testing MapInfo implementation.

You can download detailed information about the conversion and grid shift files from the Intergovernmental Committee 
on Surveying and Mapping (ICSM) web site:

http://www.icsm.gov.au/icsm/gda/gdatm/

To use the AGD 1984 to GDA94 conversion instead of the AGD 1966 to GDA94 grid shift file for all of Australia:

• Remove or rename the A66_National.gsb file in your MapInfo Professional program directory

New Zealand
New Zealand grid shift files convert from coordinates in the NZGD49 datum to the NZGD2000 datum. The grid shift file 
is:

• nzgd2kgrid0005.gsb

You can find detailed information and an online converter on this web site:

http://www.linz.govt.nz/core/surveysystem/geodeticinfo/geodeticdatums/nzgd49tonzgd2000/index.html
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To ignore the grid shift file for all of New Zealand:

• Remove or rename the nzgd2kgrid0005.gsb file in your MapInfo Professional program directory

Germany
The grid shift file for Germany is:

• BETA2007.gsb

This file is used for converting from the DHDN datum to the ETRS89 datum. You can find detailed information and an 
online converter at this web site:

http://crs.bkg.bund.de/crseu/crs/descrtrans/BeTA/de_dhdn2etrs_beta.php

To ignore the grid shift file for all of Germany:

• Remove or rename the BETA2007.gsb file in your MapInfo Professional program directory

Note: The NTv2 algorithm and grid shift files for Canada are protected under the following copyright: © 1995 Her 
Majesty the Queen in Right of Canada, represented by the Minister of Natural Resources.

Progress and Resolutions of Outstanding Issues in 9.0.2
The following issues have been corrected for the maintenance release of MapInfo Professional.

Data/Remote Database Issues Resolved

EOLS Issue Resolved

Issue Number Description/Resolution

T22192 Issue Description: Users noticed that if you open a live remote table and the table is updated on the server, the 
new record(s) do not display unless you refresh the browser. 

Resolution: We have corrected this issue to refresh live tables when they are updated on the server.

B10076 Issue Description: When opening a MS Access table using ODBC, MapInfo Professional would close suddenly 
if the database path was too long (over 97 characters). 

Resolution: We have corrected this issue to allow longer file names and paths of over 500 characters.

T23809 Issue Description: Some users have reported that tables created before the 9.0 version with a “date” datatype 
download as “datetime” in 9.0.

Resolution: We corrected how MapInfo Professional retrieves field types from the server to ensure that the 
correct datatype is retrieved.

Issue Number Description/Resolution

S10006 Issue Description: There was an issue for EOLS users who geocoded in interactive mode. If there were no 
candidate address matches and you clicked the Ignore button, MapInfo Professional closed suddenly.

Resolution: We have corrected this issue.
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Geocoding-Related Issues Resolved

Import/Export Issues Resolved

Localization Issues Resolved

Issue Number Description/Resolution

S10006 Issue Description: There was an issue for EOLS users who geocoded in interactive mode. If there were no 
candidate address matches and you clicked the Ignore button, MapInfo Professional closed suddenly.

Resolution: We have corrected this issue.

T19354 Issue Description: Geocoding data with illegal characters and embedded ASCII control characters causes the 
whole geocoding process to fail without reporting the problematic data. This makes it very difficult to find the 
record that is causing the error. 

Resolution: We resolved this issue by percent encoding the ASCII characters 0x01 - 0x1F and 0x7F - 0xFF in 
the XML we send. This prevents the illegal characters from stopping the process.

T23432 Issue Description: You can use MapInfo Professional to create a .TAB file from a text table and update the 
attribute data within it, but you cannot edit the attribute data in the original text table itself. Further, you should 
not create new records from text files that do not contain attribute data because you cannot map that type of 
table. Some customers reported, though, that you could use the Geocode Using Server option to insert text 
records with no attribute data. This resulted in tables that you could not label and for which you could not get 
tooltip information. 

Resolution: We have upgraded MapInfo Professional to ensure that tables can be geocoded and edited before 
performing the Geocode using Server option. 

Issue Number Description/Resolution

T23895 Issue Description: When you tried to import an incorrectly created MID/MIF file, MapInfo Professional did not 
import the file, nor did it report the error. 

Resolution: When you try to import a bad MID/MIF file, an error message displays to describe the column that 
contains the unsupported data type.

Issue Number Description/Resolution

T17123 Issue Description: When users performed a File > Save copy on a table with over 30 characters of mixed 
single and double byte characters, the file name was truncated and errors resulted.

Resolution: This error no longer occurs. We have corrected this issue by changing the code to count characters 
rather than bytes.

T23126 Issue Description: When you open the Map Ruler window in a locale that reads right to left (as in Hebrew or 
Arabic), the text inside the dialog box does not display correctly and the words or characters are in the wrong 
order. 

Resolution: We have corrected these issues so that the text that displays in these locales displays 
appropriately whether you open the Map Ruler window by itself or with another map tool. 
MapInfo Professional 9.0.2 Release Notes 7



Map-Related Issues Resolved

T23973 Issue Description: Some users found that MapInfo Professional did not open PNG files when the path to those 
files contained double byte and other non-ASCII characters.

Resolution: We corrected this issue by upgrading our third-party imaging tool. This tool no longer requires a file 
name conversion to Unicode, which prevented the use of non-ASCII characters.

T24056 Issue Description: In testing we found that operators for right-to-left languages were reversed when they 
displayed in the interface lists. This was first found in the SQL Select tool but was verified in other areas of the 
user interface.

Resolution: We have corrected this issue so that the operators display correctly in the SQL Select and any 
drop-down list that displays operators. 

T22436 Issue Description: There are right to left language issues when using curved labels. 

Resolution: See Support for Bidirectional Labels Added.

Issue Number Description/Resolution

T15709 Issue Description: Users reported issues when placing a legend for a pie chart thematic map into a Layout 
window. If you used the File > Save Window as operation and changed the resolution of the layout image to 
between 96 and 300 dots per inch, the legend image in the resulting bitmap changed size. In our testing we 
found that this distortion occurred when saving other image formats, such as jpg, png, etc. as well.

Resolution: This has been corrected so that you can save bitmaps in the Layout window without changing the 
image size of the legend glyph. This issue was part of a larger set of label enhancements corrected in this 
maintenance version of MapInfo Professional.

T23870 Issue Description: When you open the Page Setup dialog box (File > Page Setup) using the Vista operating 
system, the Printer button, which allows you to select a Printer does not display.

Resolution: The Page Setup dialog box is actually a Microsoft dialog box. For your convenience, we have 
modified the Page Setup dialog box to redisplay the Printer button for Vista operating system users to ensure 
that this capability matches the MapInfo Professional functionality of other operating systems.

T20448 Issue Description: Typically, when you make selections in a Map window, the Unselect and Invert Selection 
options enable. Users reported a problem accessing these options after they loaded a MapBasic application. 
Once the application was loaded, the selection was still in place but the Unselect and Invert Selection options 
were disabled. This occurred no matter what MapBasic program you ran.

Resolution: This error was corrected. 

T21121, 
T24494

Issue Description: When you use the Backspace key during the Autotrace and Snap features, nodes appear to 
be ignored. Users reported strange results when using the Backspace key. 

Resolution: This has been corrected. When you used the Backspace key during an Autotrace operation, 
MapInfo Professional interpreted it to mean you wanted to delete the previous node. We have corrected this for 
the Autotrace feature when using the Ruler, Polygon Select, Add Polyline, Add Polygon, Custom Polyline & 
Custom Polygon tools.

T21319 Issue Description: If you open a .TAB file by double clicking it or use the Layer Control options to do so, 
MapInfo Professional was not using the “Display Vertical Mapper GRD files as” settings made in the System 
Settings Preferences.

Resolution: This issue was corrected to include these opening methods.

Issue Number Description/Resolution
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T21330 Issue Description: In the past, you could change the font color from the MapBasic message window. Since 
MapInfo Professional 8.5 you could not.

Resolution: This error was based on a discrepancy in how the colors were defined in MapBasic versus how 
they were defined in Windows and may have been a consequence of the new ability to copy and paste from the 
MapBasic window. This issue has been resolved. 

S10005 Issue Description: After copying and pasting region objects into a new layer, the Combine functionality is 
disabled until you select another tool.

Resolution: We have updated the menu item functions that caused this problem. 

T18299 Issue Description: When you move an object in a Bar or Pie Chart thematic map, the dimensions of the object 
appear to change.

Resolution: This issue has been corrected. This occurred when you created a Bar or Pie Chart thematic map, 
changed the zoom of the map and then moved the object. MapInfo Professional was trying to compensate for 
the change in zoom. We have corrected the code so this no longer occurs.

T21379 Issue Description: In the past, if you created points from an ASCII text file in MapInfo Professional and then 
created a new map window and changed the symbol style, the new map data would appear to be corrupted. 
When you opened a Browser on this data, all of the values would be the same.

Resolution: This issue has been resolved. Due to an internal error, the Browser window was displaying the the 
wrong information; the actual data in the table was unaffected.

T22393 Issue Description: Curved labels were not showing up in MWS files.

Resolution: We are now writing the necessary XML structure to MWS workspaces.

T24342 Issue Description: Curved labels with small fonts seem to cause MapInfo Professional to close suddenly at 
certain zoom levels. 

Resolution: To avoid the sudden closure, MapInfo Professional now turns off font outline hinting when the font 
size is less than 7 points. For curved labels using point sizes higher than 6 points, we use hinted fonts because 
they give a crisper look, particularly for fonts with serifs. 

T24245 Issue Description: When opening GEOTIFF raster images, a black band displays at bottom of the image.

Resolution: This has been corrected. TIFF images stored in the Planar format has three planes, a red plane, a 
green plane and a blue plane. MapInfo Professional now handles these planes properly so that the image is 
displayed as expected.

T13992 Issue Description: When creating a customized ranges thematic map, the legend preview did not match the 
printed legend.

Resolution: MapInfo Professional was using a slightly different process in the preview dialog box than the print 
code was using, which caused this discrepancy. This has been corrected so the preview and the printed legend 
match.

Issue Number Description/Resolution
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Printing-Related Issue Resolved

Selection and Query Issues Resolved

Tool-Related Issues Resolved

Issue Number Description/Resolution

T23870 Issue Description: When you open the Page Setup dialog box (File > Page Setup) using the Vista operating 
system, the Printer button, which allows you to select a Printer does not display.

Resolution: The Page Setup dialog box is actually a Microsoft dialog box. For your convenience, we have 
modified the Page Setup dialog box to redisplay the Printer button for Vista operating system users to ensure 
that this capability matches the MapInfo Professional functionality of other operating systems.

Issue Number Description/Resolution

T24146 Issue Description: Some Select statements created in MapInfo Professional versions 8.X throw an invalid key 
type 7 error when run in version 9.0.

Resolution: MapInfo Professional was handling tables with the column DT_GRAPHIC improperly, which was 
causing this error. Now this column type is handled correctly.

T17317 Issue Description: Some queries using multiple column order by clauses did not get sorted correctly.

Resolution: To correct this, we expanded the maximum key length for temporary indices from 128 to 255. We 
would like to change the limit for permanent indices, but that could create backward compatibility issues and 
would involve versioning our index files.

T20448 Issue Description: Users reported that if you make a selection and then invoke a MapBasic application, the 
Unselect and Invert Selection icons and the Unselect and Invert Selection options in the Query menu are 
disabled.

Resolution: These issues have been corrected. 

Issue Number Description/Resolution

T22585 Issue Description: After using the Drag Map tool to copy layers, the next time you create a window, it is created 
in an unexpected position.

Resolution: This no longer happens. Windows created in this circumstance are now created in the expected 
position and include the tiled windows that were saved in a workspace.

T23191 Issue Description: When using the Distance Calculator tool, the Origin and Destination columns are too short if 
the source tables have longer fields. 

Resolution: This issue has been resolved by increasing the Origin and Destination column widths in this tool to 
100 characters. This should provide the flexibility of wider columns without the irritation of too-wide columns in 
the Browser window.

T24278 Issue Description: Users have reported several issues with the Grid Tools MBX program 

Resolution: We have updated the Grid Tools MBX so that it correctly handles tables and map windows that are 
not in a Longitude Latitude coordinate system. Also, you can now use the Grid Tools grid-specific Info tool to 
query any number of grid layers within a map window. Earlier versions of the Grid tool examined only the top-
most grid layer. 
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Vista Issue Resolved

New Feature Manipulation Engine (FME) Files Resolve Issues
In the last version of MapInfo Professional, we added the ability to open AutoCAD®, Microstation Design®, ESRI 
ArcSDE® and Personal Geodatabase® data directly using a third-party tool called the Feature Manipulation Engine 
(FME). Safe Software, our third-party partner, has provided updated files which improve the functionality MapInfo 
Professional is able to provide. Some of these changes also affect the Universal Translator. Below are some of the 
issues you will see resolved by installing this release.

T23538 Issue Description: The Layout Template tool errors and then closes when you select the Modify Layout 
Template option but do not select a template before clicking OK.

Resolution: The error message, "Please reselect" now prompts you to reselect the appropriate template. The 
Layout Template tool no longer closes due to this action.

S10006 Issue Description: There was an issue for EOLS users who geocoded in interactive mode. If there were no 
candidate address matches and you clicked the Ignore button, MapInfo Professional closed suddenly.

Resolution: We have corrected this issue.

T14482 Issue Description: When you create a file while using the Register Vector tool in MapInfo Professional closes 
suddenly.

Resolution: This behavior has been corrected and the Register Vector tool works properly. 

T22463 Issue Description: Users found that the Register Vector tool would not permit using FME-based .TAB files. 

Resolution: This has been corrected. The Register Vector tool was not originally set up to work with read-only 
files. As of this release, we have removed that restriction for FME-based tables.

Issue Number Description/Resolution

T24093 Issue Description: Some Vista users described a display issue where dragging a MapInfo Professional toolbar 
across the screen would temporarily erase parts of the screen. Typically these users were using the Aero color 
scheme. 

Resolution: This issue has been corrected and no longer occurs.

Issue Number Description/Resolution

Issue Number Description/Resolution

T20082, 
T20339, 
T23713

Issue Description: The Universal Translator seems to no longer use table indexes for Swedish and Finnish 
tables. Users have been seeing the error message, “No specified layers were found in MapInfo Dataset. 
Translation fails”. This feature worked in earlier versions of the product.

Resolution: In MapInfo Professional 8.5, we updated the Swedish character table, which appears to have 
caused this issue. The tables necessary to read the indexes have been updated to correct this problem.
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Progress and Resolutions on Outstanding Issues in 9.0.1
Please review the following list of issues to learn more about the changes we have made in this 9.0.1 upgrade.

Node-Locked License Issues Resolved
Node-locked licenses provide unlimited use of MapInfo Professional on an individual computer. You can return a node 
locked license and activate it again if you are changing computers or if you are changing a significant number of 
computer components. 

T20339 Issue Description: Users reported that they were unable to translate the new DateTime or Time fields to other 
non-native formats. 

Resolution: In this release, we have included updated files from Safe Software that include these new 
datatypes to allow the proper translations to occur.

T22877 Issue Description: Several failures occurred when the FME tried to translate .MIF files to the E00 format due to 
memory issues.

Resolution: Due to changes in memory management within FME, new default limits prevent most memory 
issues with FME translations from occurring.

Issue Number Description/Resolution

Issue # Description/Resolution

T23686 Issue Description. Customers with node-locked licenses with a Product ID other than MAPINFO PROFESSIONAL 
NEW PURCHASE;VERSION=9.0 could not transfer licenses. As a result, customers with this issue could install 
MapInfo Professional but could not return it to Pitney Bowes MapInfo for transfer to another computer.

Resolution: This issue has been corrected. MapInfo Professional now refers to the Activation ID rather than the 
product name for activation.

T23687 Issue Description. Some customers who purchased the node locked licensed product reported this error, Unable to 
validate your license due to error -97 (or -15) at startup before the Activation process began.

Resolution: This issue has been fixed.

23850 Issue Description. When the courtesy license term was completed, some users reported the following error: Lost 
license, cannot reconnect: Feature has expired. Users did not report any loss of functionality in the use of MapInfo 
Professional as a result of this error. 

Resolution: We corrected the code that resulted in the display of this message to ensure that it does not display.

T23688 Issue Description. Users who chose the email activation method preferred not to go through two passes to complete 
the activation process.

Resolution: We have corrected the courtesy license process to prevent this error from occurring.

T23738 Issue Description. After appearing to complete either an Internet or an e-mail activation without errors, some 
customers found that the License Activation dialog box continued to display when they opened MapInfo Professional.

Resolution: This issue occurred due to an inaccurate entry of the activation ID. MapInfo Professional erroneously 
reported that the license was activated successfully, when in fact, it was not. We have corrected this issue.
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Raster Imagery Improved
In this version of MapInfo Professional we have updated one of our raster handler tools, which corrected some long-
standing issues and improved support for many raster image formats, including:

• JPEG

• JPEG2000

• ECW 

• GeoTIFF

Further, this upgrade corrected issues relating to the use of non-Latin-1 characters, specifically:

• Issues that occurred when a raster image’s path or filename contained non-Latin-1 characters 
• Issues that arose when using non-Latin-1 characters in the Save Window As process

We also improved the georeferencing of some GeoTIFF files that contained coordinates that were in a different unit 
system than the projection uses.

T23604 Issue Description: Some users experienced very slow response time  when opening large workspaces while using a 
concurrent license.

Resolution: This issue occurred due to repeated checking for licensing information. We have corrected this issue by 
checking for the validity of the license only once.

T23706 Issue Description: Some customers found when borrowing a license that they would get the error message: No 
Matching License For Request when the License Server had a "MapInfo Professional Maintenance Upgrade" license.

Resolution: We have changed our code to ask for different matching criteria on the server to prevent this error.

T23738, 
T23793

Issue Description: A customer received an incorrect serial number and access code from the Pitney Bowes Licensing 
System (FNO). Upon Internet activation, the user received a successful activation message, but when the Help > About 
dialog box was reviewed, only the courtesy license was displayed. Upon closing MapInfo Professional and reopening it 
to a new session, the licensing dialog box displayed again requesting permanent activation.

Resolution: The product version numbers were incorrectly recorded. We have amended our in-house licensing 
procedure to correct this problem and ensure that it does not recur.

T23737, 
T23686

Issue Description: Some users were found that when they were upgrading MapInfo Professional, they were not 
prompted to transfer the license back to Pitney Bowes MapInfo.

Resolution: When performing an upgrade, you do not check out a license, we only review the registry for the serial 
number, as such you are not prompted to return the license. You are still able to return the license based on the 
activation ID you have.

T23763 Issue Description: When you borrow a license from a License Server and you already have a permanent node lock 
license, the date that displays in the About your borrowed license dialog box is incorrect.

Resolution: We have corrected this issue so that the correct date displays.

Issue # Description/Resolution
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Issue # Description/Resolution

T16643 Issue Description. Some GeoTIFF images displayed incorrectly in MapInfo Professional due to issues in the raster 
handler we were using to display them. 

Resolution: We have upgraded the libraries used to display GeoTIFF images to resolve this issue. 

T16165 Issue Description. MapInfo Professional could not open JP2 raster files. Error stated that the Raster Engine was 
unable to recognize the format.

Resolution: Upgrading our ECW file handler and other files resolved this issue.

T23078 Issue Description. GeoTIFF Images open as all black in MapInfo Professional 9.0, and cannot be opened at all in 
earlier versions.

Resolution: Upgrading our raster image handling tools prevents this problem.

T17625 Issue Description. Customers found instances where converting an EMF and some WMF raster images seemed to 
overlay the original TAB file incorrectly. This turned out to be a resolution issue where the EMF file was being saved 
using different storage units (millimeters and pixels) than usual screen resolution units (dots per inch). WMF display 
seem has been more successful because they are at the advertised resolutions.

Resolution: Upgrading our raster image handling tools allows MapInfo Professional to set the resolution for an EMF 
image differently, which resolves this problem.

T23973,
T23995

Issue Description: In MapInfo Professional version 9.0, if you saved using the Save Window As feature and you 
included non-Latin-1 characters in the target’s path or file name, the characters became corrupted. 

Resolution: We have corrected this issue to prevent the character corruption. This issue occurred because in the 
previous version of the raster handler, we needed to convert file name strings to Unicode, which we no longer need to 
do.

B10081, 
T30879

Issue Description. Customers reported that JPG raster files were not displaying correctly in version 9.0 although 
they opened correctly in version 8.5.

Resolution: This issue was corrected by the upgrade of our raster tools.

T21581, 
T16165, 
T15515, 
T20976

Issue Description: Customers reported receiving an error, “Raster engine was unable to recognize image file 
format” or displayed the image as black when trying to open JP2 files.

Resolution: This issue appears to be related to variant versions of the JPEG 2000 format. Upgrading our raster 
handler engine resolves this issue.

T23078 Issue Description: A partner reported that some GeoTIFF files display as all black in the current version of MapInfo 
Professional and did not open at all in previous versions. Georeferencing information in these files are not used.

Resolution: This was caused by an error in the raster handler we were using. The upgraded raster handler has 
corrected this issue and the GeoTIFF files now display.

T23331, 
T22015

Issue Description: Opening GeoTIFF files in MapInfo Professional resulted in registration errors.

Resolution: This issue was caused by GeoTIFF images that were saved using meters in the projection rather than 
feet. We perform this recalculation internally now to prevent this issue.

T23491 Issue Description: A customer reported that MapInfo Professional 8.5 could not open WMF files that it could open in 
previous versions.

Resolution: The previous version of our raster handler was attempting to load the WMF file at full resolution. We 
have corrected this issue by lowering the resolution of the image until it can successfully load. 
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T22015 Issue Description: We found that GeoTIFF images were registering differently between MapInfo Professional and 
ESRI products. Upon investigating this issue, we found this display issue was caused by a difference in units (meters 
vs. Survey Feet). 

Resolution: We use new libtiff and libgeotiff libraries to determine the control points and the scale factors of a 
GeoTIFF image. This issue has been resolved by upgrading our raster handler to a newer version.

23091 Issue Description: Some users found that MapInfo Professional treated ECW Files with associated World files as 
raster images without image registration information.

Resolution: To correct this issue, we updated the World file handling in the raster engine. These files now display 
correctly. 

Issue # Description/Resolution
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